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FCC COMPLIANCE STATEMENT
FOR AMERICAN USERS

This equipment has been tested and found to comply with the limits for a class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio or television reception. However, there is no guarantee that interference will
not occur in a particular installation. If this equipment does cause interference to radio
and television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the
following measures:

Q Reorient or relocate the receiving antenna
Q Increase the separation between the equipment and receiver

Q Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected

Q Consult the dealer or an experienced radii/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will
invalidate the FCC Certification of this device and may cause interference levels which
exceed the limits established by the FCC for this equipment. It is the responsibility of
the user to obtain and use a shielded equipment interface cable with this device. If this
equipment has more than one interface connector, do not leave cables connected o
unused interfaces.

Changes or modifications not expressly approved by Epson America, Inc., could void
the user's authority to operate the equipment.

FOR CANADIAN USERS

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus as set out in the radio interference regulations of the Canadian
Department of Communications.

Le présent appareil numéique n’émet pas de bruits radioélectriques d&passant les
limites applicables aux appareils numériques de Classe B prescrites dans le réglement
sur le brouillage radioélectrique édicté per Ministére pas Ministére des Communications du
Canada.
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Getting Started

The EPSON® ActionLaser™ 1400 printer combines high
performance and reliability with a wide range of features.

To get started with your ActionLaser printer, please:

Q3 Read the safety information, laser printer precautions, and
important safety instructions in this introduction.

Q Use your Read This First guide to set up and test your new
printer.

Q Refer to this Reference Guide for detailed information about
your printer.

Where to Get Help for U.S. and Canadian Users

Epson America provides local customer support and service
through a nationwide network of authorized EPSON dealers
and Service Centers.

If you need to call for technical assistance, please print a test
sheet and have it handy. To print a test sheet, turn the printer
on and then briefly press the reset button on the back of the
printer. (Make sure the Error light is not on.)

EPSON also provides the support services listed below
through the EPSON Connection.™ U.S. users can Cd

(800) 922-8911; Canadian users can call (800) GO-EPSON.

3 Assistance in locating your nearest Authorized EPSON
Reseller or Service Center

G Technical assistance with the installation., configuration,
and operation of EPSON products
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& EPSON technical information library fax service

Q Product literature with technical specifications on EPSON’s
current and new products

Q Customer Relations.

You can purchase supplies, parts, documentation, and
accessories by calling EPSON Accessories at (800) 873-7766
(U.S. only).

CompuServe®on-line support

The fastest way to access helpful tips, specifications, drivers,
application notes, and bulletins is through the Epson America
Forum on CompuServe.

If you are not currently a member of CompuServe, you are
eligible for a free introductory membership as an owner of an
EPSON product This membership entitles you to:

Q An introductory $15 credit on CompuServe
& Your own user ID and password

Q A complimentary subscription to CompuServe Magazine,
CompuServe’s monthly publication

To take advantage of this offer, call (800) 848-8199 in the United
States and Canada and ask for representative #529. In other

countries, call (614) 529-1611 or your local CompuServe access
number.

If you are already a CompuServe member, simply type

GO EPSON at the menu prompt to reach the Epson America
Forum.
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Safety Information

Laser safety

This printer is certified as a Class 1 laser product under the U.S.
Department of Health and Human Services (DHHS) Radiation
Performance Standard according to the Radiation Control for
Health and Safety Act of 1968. This means that the printer does
not produce hazardous laser radiation.

Since radiation emitted by the laser is completely confined
within protective housings and external covers, the laser beam
cannot escape from the machine during any phase of user
operation.

CDRH regulations

The Center for Devices and Radiological Health (CDRH) of the
U.S. Food and Drug Administration implemented regulations
for laser products on August 2, 1976. Compliance is mandatory
for products marketed in the United States. The label shown
below indicates compliance with the CDRH regulations and

must be attached to laser products marketed in the United
States.

This Product compilies with

reguiations 21CFR Chapter 1,

Subchapter 4, section 1010, 1040,
Epson Americq, Inc.
20770 Madrona Ave.
Torance, CA 90503 USA
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W Warning:
Use of controls, adjustments, or performance of procedures
other than those specified in this guide may result in
hazardous radiation exposure.

Your printer is a Class 1 laser product as defined in IEC 825
specifications. The label shown below is attached in countries
where required.

KLABSE 1 LASER PRODUKT LT IEC X5
LUOKAN 1 LASERLATTE

Internal laser radiation

Max Radiation Power 5mW
Wavelength 780nm

This is a Class Il1b Laser Diode Assembly that has an invisible
laser beam. The printer optical unit is NOT A FIELD SERVICE
ITEM. Therefore, the optical unit should not be opened under
any circumstance.

Ozone emission

During printer operation, a small amount of ozone is released.
This amount is not large enough to affect human beings
adversely.

However, it is best to make sure the room where you are using
the printer has adequate circulation, especially when you are
printing a high volume of materials or using the printer
continuously over a long period of time.
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laser Printer Precautions

This printer uses laser technology. The following list of
precautions applies whenever you open the cover. Even if you
are familiar with other types of printers, be sure to follow these
precautions carefully to ensure safe, efficient Operation

2

Avoid touching the components inside the printer unless
instructed to do so in this guide.

When you open the printer or remove the toner cartridge,
you expose components inside the printer that can be very
hot. Avoid touching the fuser area, which is located
immediately above the toner cartridge when you open the
front cover, and the motor, which is farther inside the
printer.

Do not scratch the surface of the drum, which is the green
cylinder that can be seen through an opening of the toner
cartridge. Avoid touching the drum, since oils from your
skin can permanently damage its surface and may affect
print quality.

Avoid pressing on the top of the toner cartridge. Pressing
directly on the cartridge may cause toner to spill into the
printer. If there is a spill, see Chapter 3 for cleaning
instructions.

Never force the printer’s components into place. Although
the printer is designed to be sturdy, rough handling can
damage it.
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The toner cartridge is the part of the printer mechanism that
forms the image and transfers it onto the paper. Keep the
following guidelines in mind whenever you handle the toner
cartridge:

Q

Q

When removing the toner cartridge, avoid exposing it to
room light any longer than necessary. Exposure to light can
damage the drum, causing dark or light areas to appear on
the printed page and reducing the life of the drum. If you
need to keep the cartridge out of the printer for long
periods, keep it in a dark, dry place.

Do not turn the cartridge upside down or stand it on its
sides.

Do not attempt to modify or take apart the cartridge. It
cannot be refilled.

Try not to touch the toner and avoid all contact with your
eyes.

Do not use a cartridge for at least one hour after moving it
from a cool to a warm environment.

To get the best print quality from your toner cartridge, do not
store it in locations that are subject to direct sunlight, dust, salty
air, or corrosive gasses (such as ammonia). Also avoid locations
subject to high temperatures or humidity or abrupt changes in
temperature or humidity.
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Important Safety Instructions

Read all of these instructions and save them for later reference.
Follow all warnings and instructions marked on the printer.

Q Unplug the printer before cleaning. Clean with a damp
cloth only. Do not spill liquid on the printer.

Q Do not place the printer on an unstable surface or near a
radiator or heat register.

Q Do not block or cover the openings in the printer’s cabinet.
Do not insert objects through the slots.

Q Use only the type of power source indicated on the
printer’s label.

Q Connect all equipment to properly grounded power
outlets. Avoid using outlets on the same circuit as
photocopiers or air control systems that regularly switch
on and off.

o

Do not let the power cord become damaged or frayed.

Q If you use an extension cord with the printer, make sure the
total ampere rating of the devices plugged into the
extension cord does not exceed the cord’s ampere rating.
Also, make sure the total of all devices plugged into the
wall outlet does not exceed 15 amperes.

Q Except as specifically explained in this Reference Guide, do
not attempt to service the printer yourself.

Q Unplug the printer and refer servicing to qualified service
personnel under the following conditions:

If the power cord or plug is damaged; if liquid has entered
the printer; if the printer has been dropped or the cabinet
damaged; if the printer does not operate normally or
exhibits a distinct change in performance. Adjust only
those controls that are described in this Reference Guide.
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About this Guide

This guide contains information for operating and maintaining
the printer once you have installed it. For information about
installing and setting up the printer, see Read This First.

Chapter 1, “Using Your Printer,” lists the printer’s features and
describes how to load paper and control the printer.

Chapter 2, “Changing the Printer Settings,” describes how to
change printer settings using the Windows” printer driver.
Printer driver settings allow you to change the toner density,
specify the resolution, turn on toner saving mode, and specify
how long the printer is idle before it enters power saving mode.

Chapter 3, “Troubleshooting,” gives helpful information for
avoiding printer errors, optimizing print quality, and solving
any problems you may encounter.

Appendix A contains the technical specifications about the
printer.

Appendix B describes how to use the EPSON Control Panel for
DOS to control the printer. This appendix is intended for users
who do not have Microsoft”Windows.

Appendix C lists the commands that can be used to control the
printer. This appendix is intended for advanced users only.

Appendix D gives step-by-step instructions for installing Single
In-Line Memory Modules (SIMMSs) so you can increase printer
memory up to 18MB.
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About Your Printer

The Act&Laser 1400 is the latest in EPSON’s advanced line of
laser printers. It is driven by a powerful RISC processor and
emulates the Hewlett-Packard® LaserJet®4P (LJ4P) printer,
allowing you to print using the wide variety of software
programs that support HP®printers. You can control the
printer from either the Windows or MS-DOS" environment.

The printer gives you the ability to produce good-looking,
professional documents and publications. Its 600-dpi resolution
results in sharp, crisp text and line art and realistic grayscale
images. Its edge smoothing capability further contributes to
high-quality output by smoothing lines and edges of text and
graphics.

The Act&Laser 1400 is quiet and is easy to install and use.
YOU simply set it up and connect it to your computer using the
parallel interface as described in Read This First. To use the
printer, just bring up your software program and use the Print
menu option under your File menu. From the Print menu, you
can access the settings that allow you to control the print job
and the printer itself.

Getting the most out of your printer

The printer comes with a wide array of features that allow you
to achieve highquality output, conserve toner and power, and
easily monitor the printer status. To get the most out of your

printer, familiarize yourself with the features available to you.

High, 600-dpi resolution

Resolution can be set at 300 or 600 dpi. Both produce good-
looking, crisp text and graphics. At 600 dpi, the resolution is
exceptionally sharp because the dots that make up the text and
graphics are smaller and more numerous than those used in
300-dpi resolution.

1-2
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Generally all text and graphics look better when printed at
600 dpi. This is especially true for grayscale images because a
finer halftone screen can be applied to produce more realistic
images. The higher resolution of 600 dpi also means that more
gray shades can be represented, reducing the banding that is
sometimes apparent at lower resolutions.

Toner saving mode

The toner saving mode allows you to reduce the amount of
toner used in printing draft documents. When you turn on
toner saving mode, the printer applies less toner to each page,
causing text and graphics to appear gray rather than black. The
toner saving mode settings allow you to control how light or
dark you want the toner to be applied.

EPSON Control Panel utility

The EPSON Control Panel for Windows keeps you informed
of the printer’s status and notifies you of printing errors. Each
time the printer status changes, such as when the paper tray is
empty or an error occurs, a message automatically appears on
screen. In case of an error, the message informs you of what
steps to take to clear the error.

Note:

If you are not using the printer in a Windows environment, the
Reporter, which is included with the EPSON Control Panel for DOS,
keeps you informed of the printer status.

Memory expandable to 18MB

The printer comes with 2MB of memory, which is sufficient
for printing almost all documents. However, if you regularly
print complex, graphics-intensive pages or regularly download
multiple fonts, you may want to increase the amount of printer
memory. By inserting one or two SIMMSs, you can increase
printer memory to 18MB. See Appendix D for more

information.
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Energy star compliant

Your EPSON printer complies with the U.S. Environmental
Protection Agency's Energy Star program, which promotes the
manufacture of energy-efficient printers, computers, and
monitors. The printer conserves electricity by automatically
entering power saving mode when not in use for a specified
period of time (default is 15 minutes).

The EPA estimates that if all desktop computers, printers, and
other peripheral devices met Energy Star standards, energy
cost savings would exceed $1 billion annually and carbon
dioxide emissions would be reduced by 20 million tons.

All of EPSON’s dot matrix and ink jet printers conform to

Energy Star standards, as do all ActionLaser printers produced
after June, 1993.

The Energy Star emblem does not represent EPA endowment of any
product or service.

Optional PostScript®emulation

Optional software is available that allows you to print
documents formatted for PostScript Level 2. Call your dealer
or EPSON Accessories for more information.

14

Using Your Printer



Paper Handling
The paper tray holds up to 100 sheets of various standard-size

papers, including letter and legal. For other sizes and exact
specifications, see Appendix A.

Loading paper
To load a stack of paper in the printer’s paper tray:

1. Remove any paper remaining in the paper tray. Do not add
paper to a partial stack.

2. Pull the paper release lever toward the front of the printer.

3. Fan a stack of paper and load the paper in the paper tray.
Place the paper side you want printed face down in the
paper tray. Up to 100 sheets can fit in the paper tray.

4. Slide the paper guides against the paper stack so the paper
fits loosely between them. The paper guides should not fit
too tightly against the paper.
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5. Push the paper release lever toward the back of the printer.

This places the feed roll in contact with the paper stack.
Paper will not feed properly if the paper release lever is not
in the feed position.

For information about loading heavy paper, envelopes, labels,
or transparencies, see ‘Printing on special paper” later in this
chapter.

Choosing paper

For best results, use paper made especially for laser printers
or plain-paper copiers. Paper should be of good quality and
relatively smooth with a weight between 16 and 24 Ib (60 and
90 g/m’). Because the printer is sensitive to moisture, always
store paper in a dry place.

You may use colored paper but not paper to which a clear or
colored coating has been added. For preprinted paper stock
such as letterheads, use papers and inks designed for laser
printers. Ordinary inks or dyes may smear or come off when
subjected to the high temperature of the fuser. Always test
samples of paper stock before purchasing large amounts.

Note:

The quality of any particular brand or type of paper may be changed
by the manufacturer at any time, so EPSON cannot guarantee any
particularone.

In addition, you can print on special stock such as heavy

paper (greater than 24 1b or 90 g/m°), envelopes, labels, Or
transparencies. To do so, you need to feed single sheets one at a
time. See the next section “Printing on special paper.”

1-6
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Printing on special paper

You can print on special paper stock such as heavy paper

(over 24 Ib or 90 g/m’), envelopes, labels, and transparencies.
When selecting special types of paper or other stock, follow the
recommendations given below.

For printing on special paper, it is usually easier to use manual
feed and print a single sheet at a time. To use manual feed,
select the printer driver's Manual Feed option (see Chapter 2
for information on printer driver settings) and then send your
print job. The printer waits for you to press the reset button
before it prints a single sheet. If your document contains
multiple pages, you need to press the reset button for each

page.

Envelopes

Load envelopes with the flap-side up and to the left. The
printing quality on envelopes may be irregular because
different parts of an envelope have different thicknesses. print
one or two envelopes to check the print quality. If the printing
is too light, adjust the toner density as described in Chapter 3.

Do not use envelopes with metal clasps or fastenings. Also do
not use window envelopes unless they are specially designed
for laser printers. The plastic on most window envelopes can
melt when it comes in contact with the hot fuser.

Labels

Use only labels designed for laser printers or plain-paper
copiers. To prevent the adhesive from coming into contact with
printer parts, always use labels that completely cover the
backing sheet, with no gaps between the individual labels. You
should test the label sheet for leaking adhesive by pressing a
sheet of paper on top of a sheet of labels. If the paper sticks, do
not use the labels.
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Transparencies

You can use overhead projector transparencies and adhesive
drafting film if they are made for use with laser printers or
plain-paper copiers. Normally you should use manual feed
when printing transparencies.

Fonts

The printer comes with a set of 45 scalable resident fonts as
well as the Line printer bitmap font. The resident scalable fonts
include the following:

Coronet Albertus

Arial* Antique Olive
courier Symbol*

CG Times’ Wingdings*

CG Omega Letter Gothic
Garamond Univers*

Times New Roman* Univers Condensed
Clarendon Condensed Marigold

* TrueType" font

For a complete listing, print a test page by pressing the reset
button at the back of the printer.

If your document contains fonts that are not resident in the
printer, the fonts need to be transferred, o r downloaded, from
your computer to the printer. Windows fonts, including
TrueType fonts, are downloaded automatically. For other types
of fonts to be downloaded, you need the appropriate screen
font software. For example, to download Adobe’fonts, you
need Adobe Type Manager™ (ATM); to download Intellifont™
Scalable Typefaces from Agfa,™ you need Intellifont for
Windows.™ If you don’t have the appropriate screen font
software for a particular font, the font will not be downloaded
and the printer will substitute one of the resident fonts.
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Downloaded fonts remain in printer memory only until the
print job is completed. When the print job is completed or you
turn off the printer, downloaded fonts are flushed from
memory. Downloaded fonts, which must first be transferred
from the computer, do not print as fast as resident fonts.

If you are printing a page that consists mainly of graphics but
not a lot of TrueType text, you might want to download
TrueType as bit images as described in Chapter 2. Converting
TrueType fonts to bit images requires less printer memory and
may speed up printing. Downloading TrueType as bit images
is also useful if you want to print graphics over text so that
only a portion of the text is visible.

Monitoring the Printer Status

If you are running Windows, the printer keeps you informed of
its status in two ways:

Q The Ready and Error lights on the front panel come on or
flash depending on the current status. For example, the
Ready light begins to flash as data is sent from your
computer to the printer.

Q The EPSON Control Panel for Windows automatically
presents screens to keep you informed of the printer status
or notify you of an error. For example, each time the paper
tray is empty, a screen automatically appears to inform you
of the change in status.

Note:
If you are running the EPSON Control Panel for DOS, the Reporter

provides onscreen status and error messages to keep you informed of
the printer status.
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Front panel lights

The two lights on the front panel allow you to monitor the
status of the printer. The green Ready light is on when the
printer is on and is ready to receive print data. As data is
received from the computer, the Ready light flashes.

The orange Error light indicates an error condition. If the Error
light is on continuously, it indicates that no paper is loaded or
that there is a paper feed jam. A flashing Error light indicates
one of the following: an internal paper jam has occurred, the
front cover is open, or the toner cartridge is not installed.

Other status conditions are indicated by the combination of the
Ready and Error lights. The following table describes all status
conditions that can be indicated by the printer’s lights:

Ready Error Printer status

Off off Printer is off.

Slow Flashing | off Printer is in power save mode.

Flashing off Print data is being received at the printer or
has already been received.

On off Printer is ready to receive print data.

Off On Either the paper tray is empty or there is a

paper feed problem.

Off Flashing One of the following errors has occurred:
= Paper has jammed inside the printer.

= The front cover is open.

= The toner cartridge is not installed.

Flashing On One of the following errors has occurred:
« Insufficient memory to print job.
= Printer is in manual feed mode and is

waiting for the next sheet.
= There is a printer overrun error.

Flashing Flashing The printer is warning up.

On On A printer engine or controller error has
occurred. Contact your dealer or a
qualified service person.
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The EPSON Control Panel provides more precise information
about the printer status or any errors that occur. gee the next
section.

EPSON Control Panel for Windows

The EPSON Control Panel for Windows consists of a series of
screens that appear automatically whenever the printer status
changes and whenever the printer encounters an error. For
example, EPSON Control Panel messages appear in the
following cases:

Q The paper tray is empty.
Q The printer is off or there is a communication problem

Q@ A print error has occurred. For each error, an EPSON
Control Panel message informs you of what you can do to
correct the problem.

The message remains open on top of your software program
until you minimize the screen by clicking the Minimize button
(¥ ) in the upper right comer of the message window. To make
the EPSON Control Panel message window reappear, double-

click the EPSON Control Panel icon at the bottom left comer
of your screen.

Note:

If you are using the EPSON Control Panel for DOS, the Reporter
prooides onscreen status and error messages to keep you informed of
the printer status.
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Adjusting the Power Saving Mode

In compliance with the Energy Star program, the printer enters
power saving mode when it is idle for a specified length of time
(15 minutes by default). While in this mode, the printer
conserves energy by using less electricity.

Power saving mode is automatically interrupted whenever you
send a print job or press the reset button at the back of the
printer. It takes approximately 45 seconds for the printer to
warm up when it is in power saving mode.

You can specify how long the printer is idle before power
saving mode comes on or turn off power saving mode. For
more information, see Chapter 2.
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Changing the Printer Settings

In Windows-based software programs, you use the Print dialog
box, which is accessible through the File menu, to specify the
most common printer settings, including the number of copies,
print range, and orientation

Note:

If you are not running Windows, you control printer settings through
the EPSON Control Panel for DOS. See Appendix B for more
information.

Additional settings are provided by the ActionLaser 1400
printer driver. The printer driver settings allow you to do the
following:

Q Change the resolution

Q Turn power saving mode on and off and specify how long
the printer is idle before entering power saving mode

Q Turn on toner saving mode and specify what level of toner
saving to use

Q Control the toner density.

Other settings are described later in this chapter.

Note:

If you are using Microsoft Windows, you can also control the printer
through the Printers icon in the Control Panel. Double-&king on
the Printers icon brings up a dialog box that allows you to install and
select the printer driver, change the printers interface port, and
control the printing of your files. Normally you need to use the
Printers icon only when you first set up the printer. See your
Windows manual fOr MOFE information.
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Accessing Printer Driver Settings in Windows

To access printer driver settings, first choose Print from the
File menu to bring up the Print dialog box. You now need to
select another option Depending on your software program,
you need to choose the Setup, Options, or Printer button
Some programs then prompt you to select the ActionLaser 1400
before the Setup dialog boxes appear.

Printer driver settings are accessible on six Setup dialog boxes.
The first Setup dialog box you see is for Paper settings:

At the top of the dialog box are tabs for each Setup dialog box:
Paper, Green, Graphics, Printer, Fonts, and About. The table on
the next page lists the settings available on each.

To change a printer setting, open the appropriate dialog box by
choosing the tab. Change one or more printer settings and then
choose the OK button at the bottom of the dialog box. If you
want information about any of the printer settings, look up the
setting in this chapter or choose the Help button.
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To return the settings within a dialog box to their default

settings, choose the Default button.

Setup .
dialog box | Items Settings
Paper Papersize Letter (default)
Legal
A4
Executive
COM-10 envelope
Monarch envelope
DL envelope
C5 envelope
B5 envelope
Orientation Portrait. Landscape
Number of Copies 1-999
Paper Feed Source Automatic, Manual, Envelope
Auto continue on, off
Green Toner Saving On, Off
Edge Smoothing Off. Light, Medium, Dark
Toner Density Light, Medium, Dark
Power Saving on, off
Power Saving Interval 1-999
Graphics Graphics Mode Raster, HP-GL/2
Graphic quality High, Medium, Low
Gray Scale Photographic Images
Line Art Images
Scanned Images
True Type Mode Download as True Type
Download as bit images
User Printer True Type on, off
Fonts
Printer Printer Memory 2-18MB
Page Protection On, Off
Resolution 300, 600
Fonts Brings up the Font Manager so you can download PCL
fonts
About

Displays software version information
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Paper settings

The Paper Setup dialog box contains the settings described
below.

Paper Size

Specifies the size of paper loaded in the paper tray. Select
one of the following paper or envelope sizes:

Letter (default) 8.5 x 11 inches
Legal 8.5 x 14 inches
Ad 210x297mm
Executive 7.25 x 10.5 inches
COM-10 envelope 41/8x9.5 inches
Monarch envelope 37/8 x 7.5 inches
DL envelope 110x220 mm
C5 envelope 162x229 mm
B5 envelope 176x250 mm
Orientation

Specifies whether the page is printed in portrait or

landscape orientation. In portrait orientation, the top of the
page is parallel to the short edge of the page. In landscape
orientation the top of the page is parallel to the long edge.

Normally you should select print orientation from the Print
dialog box.

Copies

Specifies how many uncollated copies to print. This option
is provided in case your software program does not allow
you to specify the number of copies. Normally you should
use the Copies command from the Print menu to specify
the number of copies.

You can enter any number from 1 to 999. The default is 1.
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Paper Feed

Specifies whether paper or envelopes are fed automatically
from the paper tray or whether paper is fed manually. The
options for Paper Feed are Automatic (default), Manual,
and Envelope.

By default, Automatic is selected and the printer uses the
paper in the paper tray and prints pages continuously as
long as print data is received from the computer.

Use the Manual setting when you want to print a single
sheet at a time, such as when you are printing heavy paper,
labels, or transparencies. Use the Envelope setting if you
are printing on envelopes; when using Envelope feed, be
sure to specify the appropriate Paper Size setting for the
type of envelope (COM-10 is the default).

When Manual or Envelope is selected, the printer waits for
you to press the reset button It then prints a single sheet
and waits to print until you again press the reset button.

Manual and Envelope stay active only until you exit
Windows. Each time you start Windows, the paper feed is
reset to the default (Automatic).

Auto Continue

Permits the printer to automatically recover from printer
overrun and memory overflow errors and continue
printing. By default, Auto Continue is on. If a printer
overrun or memory overflow error occurs while Auto
Continue is off, press the reset button to resume.
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Green settings

The options on the Green dialog box allow you to conserve
toner and power.

Toner Saving

Allows you to use less toner when printing draft
documents. This can reduce your printing costs because
you need to replace toner cartridges less often. Toner
Saving can be one of the following: Light, Medium, Dark,
or Off (default).

The Light setting uses the least amount of toner, and the

Dark setting produces the most legible output while still
saving toner.

Setting Toner Saving to Off results in normal output and
toner usage.

Edge Smoothing

Allows you to adjust the edge smoothing feature or turn it
off. Edge smoothing improves the appearance of text and
line art by smoothing the edges of characters and line art.
For more information about edge smoothing, see Chapter 3.

The settings for Edge Smoothing are Off, Light, Medium
(default), and Dark Normally you should not need to
change the default setting. Probably you need to adjust
Edge Smoothing only in the following cases:

Q You notice the edges of text or line art are too light or
dark. To adjust for this, use the Light setting if the
edges are too dark, or use the Dark setting if the edges
are too light.

@ Some graphics that include gray shading or a screen
pattern are improved when you turn off Edge
Smoothing.
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Toner Density

Specifies the density of the toner applied to the page.
Normally, you should not need to adjust this setting. It is
provided to allow you to compensate for variations among
toner cartridges.

The settings for Toner Density are Light, Medium (default),
and Dark.

Note
Increasing the density increases the rate of tow consumption.

Power Saving

Specifies whether power saving mode is on or off.

When Power Saving is on, the printer uses less electricity
by entering a low-power state when the printer is idle for
the length of time specified by Power Saving Interval.
When the printer is in the low-power state, it takes
approximately 45 seconds for the printer to warm up once
it receives data.

In compliance with the Energy Star program, Power Saving
is factory-set to on.

Power Saving Interval

Specifies in minutes how long the printer is idle before it
enters power saving mode. Power Saving Interval can be
any value from 1 to 999 minutes. The default is 15 minutes.

Power Saving Interval is valid only when Power Saving is

on.
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Graphics settings

The following settings allow you to control the printing of
graphics:

Graphics Mode

Specifies whether images are sent to the printer as
HP-GL/2 graphics or as raster (bitmapped) graphics. The
default is HP-GL/2 graphics.

Printing images in HP-GL/2 mode is faster than printing in
raster mode. How ever, not all graphics can be printed in
HP-GL/2 mode. If you are having difficulty printing
graphics, change the Graphics Mode setting to Raster.

Graphics Quality

Specifies whether to use a lower resolution to print
graphics. The settings are High (default), Medium, and
Low. Note that Graphics Quality does not affect text.

The High setting prints graphic5 at 100% of the current
resolution setting. The Medium and Low settings print
graphics at 50% and 25% of the current resolution,
respectively.

For example, if the current resolution is 600 dpi, graphics
are printed at 600 dpi with High, 300 dpi with Medium,
and 150 dpi with the Low setting. When the current
resolution is 300 dpi, you can print graphics at 300, 150,
and 75 dpi.

For highest quality printing, use the default High setting.
Use Medium or Low if you are having difficulty printing
complex graphics or if you want faster printing.
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Gray Scale

Specifies what halftone pattern to apply to grayscale
images. The options are Photographic Images (default),
Line Art images, and Scanned Images. Each option is
described below. The best way to choose a setting for your
images is to experiment. Print a grayscale image at each
setting and choose the one you like best.

Choose Photographic Images for images that you want to
have a smooth, realistic appearance. This setting provides
soft contrasts between shades of gray and works well for
images originally designed with color. At 300 dpi, the
printer uses an 8 bit-by-8 bit “clustered dot” method to
emulate 60 levels of gray. At 600 dpi, the printer uses a

16 bit-by-16 bit method to emulate 120 levels of gray.

Choose Line Art Images for images with intricate lines
and fine detail, such as clip art images. This setting
providessolid lines and sharp contrasts between shaded
areas. When Line Art Images is selected, the printer uses
8 bit-by-8 bit “dispersed dot” patterns to produce 32 gray
tones.

Choose Scanned Images for images that were originally
scanned. In this setting the printer uses a variation of
the 8 bit-by-8 bit “clustered dot” method used in the
Photographic Images setting. This method produces

60 levels of gray at 300 dpi and 120 levels at 600 dpi.

TrueType Mode

Specifies whether TrueType fonts are downloaded as
TrueType fonts or are first converted to bitmapped images
before being downloaded. By default, TrueType fonts are
downloaded as TrueType fonts.
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You might want to first convert TrueType fonts to bit
images if your document contains a lot of graphics but not
a lot of TrueType text. In this case, printing TrueType fonts
as bit images requires less printer memory and may speed
up printing.

Printing TrueType fonts as bitmap images is also useful if
you want to overlay graphics on top of text.

Use Printer TrueType Fonts

Substitutes printer-resident TrueType fonts for TrueType
fonts contained in a document. By default, Use Printer
TrueType Fonts is on.

Using printer fonts is faster than downloading fonts from
your computer. However, there may be slight differences
between the printer fonts and the fonts on your computer.
If you require that the printed output exactly match what
you see on screen and are willing to sacrifice some printer
performance, turn off Use Printer TrueType Fonts.

Printer settings

Page Protection

When Page Protection is enabled, the printer reserves
additional memory and does not print a page until the
entire page is fully composed. This allows the printer to
Print complex pages that can otherwise cause print
overrun errors. The amount of memory that is reserved
depends on the paper size.

The sttings for Page Protection are Automatic (default),
Off, Letter, A4, and Legal.
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When Automatic is selected, the printer first analyzes each
page. If a page is complex, Page Protection is turned on
automatically for the appropriate paper size; otherwise, it
is not used.

If you continue to encounter page overrun errors even
when Page Protection is on, you may want to add more
printer memory. See Appendix D for more information.

Resolution

Chooses between 600- (default) and 300-dpi resolution
For highest quality, use 600 dpi for both text and graphics.
If you are experiencing printer memory problems or you
want faster printing, use 300-dpi resolution.

Memory

Defines the amount of memory installed in the printer.
Windows uses this information to determine the amount
of memory you have available for printing.

The Memory setting should exactly match the total amount
of memory in your printer. If you add more memory to the
printer, you need to change the Memory setting to match
the amount of printer memory. The additional memory will
not be available unless the Memory setting is correct..

If you are unsure how much memory is installed in your
printer, print a test page by pressing the reset button at the
back of the printer. (Make sure the Ready light is on and
the Error light is off.) The amount of memory (RAM) is
stated in KB.

Memory can be any value between 2 and 18MB. The
default is 2MB.
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Font settings

Choosing the Font tab brings up the Font Manager, which
allows you to install PCL-compatible fonts to your hard
disk. You need to use Font Manager only to install
PCL-compatible fonts.

For more information, use the Help button.

About settings

The About dialog box displays information about the
software version.

Controlling the Printer  2-13



2-14  Controlling the Printer



Chapter 3

Troubleshooting
Resetting the Printer - - -« « « « o oo 3-2
General Problems . . . ... ... ... ... 3-2
Print Quality Problems - - - -« « « o oo o e 3-5
Optimizing Print Qua“ty ...................... 3-8
Adjusting edge smoothing ................... 3-8
Adjusting toner density. .................... 3-10
Cleaning the Printer - - - - -« -« o oo 3-11
Cleaning the inside of the printer - - - - . . ... ...... 3-11
Removing sp|||ed toner - - -« - o e e e 3-12
C|eaning the printer CASE + + = = ¢ h e e e e e 3-13
Deleting the EPSON Control Panel for Windows - - - - - - - - 3-13

Troubleshooting 3-1



Resetting the Printer

In many cases, you can recover from a problem, such as a
printer overrun or a memory overflow, by briefly pressing the
reset button at the rear of the printer. This clears the error so
the printer can resume printing.

You can also reset the printer to clear its memory of any print
jobs currently in memory and to return to the factory defaults.
To reset the printer, press down the reset button at the back of
the printer for five seconds. Be aware that your software
settings override the default settings.

General Problems

This section describes some general problems you may
encounter and gives some suggestions on how to avoid them.

Preventing paper feed and paper jam problems

If you have frequent paper feed or paper jam problems, use this
checklist of corrective measures:

Q Use a higherquality paper that is not too thin or rough.
Some types of paper require single-sheet feeding. See
"Paper Handling” in Chapter 1.

Q Be sure to pull the paper release lever toward the front of
the printer before installing paper. After paper is installed,
push the lever back.

Q Always remove any paper remaining in the paper tray
before you load paper. Do not add more paper when paper
is already loaded.

3 Fan the stack of paper and then tap it on the edge to align it
before loading.
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Q Be sure the printer is level.
Q Do not load more than 100 sheets of paper in the tray.

O Be sure to adjust the paper guides so the paper can slide in
and out freely.

Never let more than 50 sheets accumulate in the exit tray.

Q Try turning over the stack of paper in the tray. Most paper
packages indicate which side should be face up.

Q Do not load paper while the printer is operating.

The Ready light does not turn on when you turn the printer on

Open the printer’s front cover and make sure the toner
cartridge is installed securely.

Turn off the printer and check the power cable connections
between the printer and the electrical outlet; then turn the
printer back on

If the electrical outlet is controlled by an outside source such
as a wall switch, make sure the switch is turned on or plug
another electrical device into the outlet to make sure the outlet
is operating properly.

The Ready light is on but nothing prints

Your computer may not be properly connected to the printer.
Perform the procedure ‘Testing the computer-to-printer
connection” in Read This First.

The interface cable may not be plugged in securely. Check both
ends of the cable between the printer and the computer. Be
sure to secure the connector using the wire retaining clips.
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Make sure your interface cable is shielded.

The toner cartridge may be empty. Replace the toner cartridge
as described in Read This First.

A single sheet or the last sheet doesn’t print

The file you sent might not contain a form feed command. (The
printer won't print a single page or the last page of a multi-
page document unless the file ends in a form feed command.)
To print the single sheet or last sheet, briefly press the reset
button at the back of the printer.

Some or all of the output is garbled or printed as asterisks

Make sure that both ends of the interface cable are plugged
in securely.

Make sure your interface cable is shielded.

If the printer still does not print correctly, call your dealer or a
qualified service person.

Position of the printout is not correct

Make sure that you are using the correct page length and
margin settings in your software program.

Graphics don’t print correctly

Make sure your software program supports LJ4P emulation

Graphics require large amounts of memory; if you are
encountering problems because of insufficient memory,
simplify your graphics or use fewer graphics on a page. If
you often print graphics-intensive pages, you may want to
add more memory as described in Appendix D.
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The font you selected in your software program doesn’t print

The font you selected in your software program is not a
Windows font and cannot be downloaded. To download
non-Windows fonts, you need to obtain the font screen
software appropriate for the type of font (e.g., ATM, Intellifont
for Windows).

Print Quality Problems

Dark or dirty background

Turn off the printer and remove the toner cartridge. Clean the
paper path inside the printer using a clean, soft, dry cloth.

Be sure to wipe the laser scanner window, which is located
immediately in front of the orange strip at the bottom of the
printer interior.

Clean internal printer components by printing thee pages with
only one character per page.

There may be a problem with the toner cartridge. Remove the
cartridge, shake it gently from side to side, and then reinstall it.
If this does not solve the problem, replace the toner cartridge as
described in Read This First.

Change the Toner Density setting to light print. See “Adjusting
toner density" later in this chapter.

Vertical black or white bands or lines

Install a new toner cartridge as described in Read This First and
print several pages to check the print quality.

Troubleshooting 3-5



Turn off the printer. Clean the paper path inside the printer
using a clean, soft, dry cloth Be sure to wipe the laser scanner
window, which is located immediately in front of the orange
strip at the bottom of the printer interior.

Horizontal black or white bands or black page

Install a new toner cartridge as described in Read This First.

Uneven darkness

Your paper may be moist or damp. Printing is sensitive to
moisture absorbed by the paper. Do not store your paper in a
humid or damp environment.

Take out the toner cartridge, shake it gently from side to side,
and then reinstall it.

If this does not solve the problem, install a new toner cartridge
as described in Read This First. Then print several pages to
check the print quality.

Toner smudges

Remove the toner cartridge, shake it from side to side to
distribute the toner, and wipe the bottom of it with a clean, dry
cloth.

Turn off the printer. Clean the paper path inside the printer
using a clean, soft, dry cloth. Be sure to wipe the laser scanner
window, which is located immediately in front of the orange
strip at the bottom of the printer interior.

Clean internal printer components by printing three pages with
only one character per page.

If the problem remains, replace the toner cartridge as described
in Read This First.
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Missing areas on printed image

Your paper may be moist or damp. Printing is sensitive to
moisture absorbed by the paper. The higher the moisture
content in the paper, the lighter the printed output. Do not
store your paper in a humid or damp environment.

You may not be using the correct type of paper for your
printer. If the surface of your paper is too rough, printed
characters appear distorted or broken Smooth, highquality
copier paper is recommended for best results. See Chapter 1
for information on choosing paper.

Completely blank pages

Check to be sure the toner cartridge is installed as described in
Read This First.

The toner cartridge may be empty. Replace the cartridge.

The problem may be with your software program or interface
cable. Print a test sheet by briefly pressing the reset button on
the back of the printer (make sure the Error light is not on).

If the test page is blank, the problem is with the printer. Call
your dealer or a qualified service person.

Printed image is light or faint

The toner cartridge is probably empty. Replace the toner
cartridge as described in Read This First.

Your paper may be moist or damp. Printing is sensitive to
moisture absorbed by the paper. The higher the moisture
content in the paper, the lighter the printed output. Do not
store your paper in a humid or damp environment.
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Take out the toner cartridge, shake it gently from side to side to
distribute the toner, and then reinstall it. If the problem persists,
replace the toner cartridge as described in Read This First.

Use the printer driver’s Toner Density item for darker print.
See “Adjusting toner density” later in this chapter.

Image is too dark

Use the printer driver’s Toner Density item for lighter print.
See “Adjusting toner density” later in this chapter. If the

problem persists, replace the toner cartridge as described in
Read This First.

Non-printed side of the page is dirty

Toner may have spilled in the paper feed path. Turn off the
printer. Remove the toner cartridge and then clean the paper
path of the printer using a clean, soft, lint-free cloth. Be sure
to wipe the laser scanner window. This window is located

immediately in front of the orange strip at the bottom of the
printer interior.

Optimizing Print Qualify

If the quality of your printouts is not good, read the following
sections for information on enhancing the print quality.

Adjusting edge smoothing
The edge smoothing feature improves the appearance of text

and graphics by smoothing the jagged edges of characters and
line art, resulting in higher quality output.
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The settings for Edge Smoothing are Off, Light, Medium
(default), and Dark Normally you should not need to change
the default setting. Probably you need to adjust Edge
Smoothing only in the following cases:

Q

Q

You notice the edges of text or line art are too light or dark.
To adjust for this, use the Light setting if the edges are too
dark, or use the Dark setting if the edges are too light.

Some graphics that include gray shading or a screen
pattern are improved when you turn off Edge Smoothing.

To change the Edge Smoothing setting:

1.

From your software program, choose Print or Page Setup
in the File menu.

Then choose the Setup option. (Depending on your software
program, you might need to select Options or Printer.)

If necessary, select the ActionLaser 1400 in the list of printers.
(Not all software programs prompt you to select the printer.)

In the Setup dialog box for the ActionLaser 1400, choose the
Green tab.

Change the Edge Smoothing setting as appropriate.

Choose OK Then close all screens by choosing OK or Close
as appropriate.

If your printed images still need to be improved, you probably
need to change the Toner Density setting. For a darker edge
smoothing setting, make the toner density lighter and vice
versa. See the next section, “Adjusting toner density.”
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Adjusting toner density

Note:

Do not change the toner density unless it is necessary. Changing the
toner density affects all text and graphics, so check the new setting by
printing several pages with various kinds of text and graphics.

If your printed pages are too light or too dark, adjust the toner
density as follows:

1. From your software program, choose Print or Page Setup
in the File menu.

2. Then choose the Setup option (Depending on your
software program, you might need to select Options or
Printer.)

3. If necessary, select the ActionLaser 1400 in the list of
printers. (Not all software programs prompt you to select
the printer.)

4. In the Setup dialog box for the ActionLaser 1400, choose the
Green tab.

5. Change the Toner Density setting as appropriate.

6. Choose OK. Then close all screens by choosing OK or Close
as appropriate.

Note:

Increasing the toner density increases toner consumption. If you
select darker print, you may need to replace the toner cartridge more
Often.
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Cleaning the Printer

The printer needs only minimal cleaning. If you notice a
decline in print quality, clean the inside of the printer as
described in this section. You should also clean the printer’s
outer case every few months.

Whenever you dean the printer or replace components, print a
test sheet by pressing the printer’s reset button.

Cleaning the inside of the printer

Fine particles of paper dust and ordinary dust can collect inside
the printer. Follow the steps below to clean the inside of the
printer:

1. Make sure the printer is turned off.

2. Open the printer's front cover.

w Warning:

8 When you open the printer or remove the toner cartridge,
you expose components inside the printer that can be very
hot. Avoid touching the fuser area, which is located
immediately above the toner cartridge when you open the
front cover, and the motor, which is further inside the
printer.

3. Remove the toner cartridge.
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4. Remove any dirt inside the printer with a soft, clean cloth.
Do not use compressed air.

Be sure to clean the laser scanner window. This window
is located in the lower area of the printer interior,
immediately in front of the orange strip.

5. Reinstall the toner cartridge.
6. Close the front cover.

7. Remove any pages and clean the paper tray with a soft cloth.

Removing spilled toner

If toner spills inside the printer, do not use the printer until you
remove all the spilled toner. Follow these steps:

1. If only a small amount of toner is present, remove the toner
cartridge and carefully wipe out the inside of the printer
with a clean, dry cloth Be sure to clean the laser scanner
window, which is located in the lower area of the printer
interior immediately in front of the orange strip.
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2. If a large amount of toner is present, use a small vacuum
cleaner (available from computer supply stores) to remove
it. Then carefully wipe with a clean, dry cloth.

Caution:

Toner or any other fine powder can damage some vacuum
cleaners. Be sure to read the instructions for your vacuum
cleaner before you use it on spilled toner.

Note:
If you spill toner on your clothing, rinse it off with cold water. Do not
use hot water; it may cause the toner to leave a permanent stain.

Cleaning the printer case

If the printer’s outer case is dirty or dusty, turn off the printer
and clean it with a soft, clean cloth dampened with a mild
detergent.

Caution:

Never use alcohol or thinner to clean the printer’s outer case;
these chemicals can damage the components and case. Be
careful not to get water on the printer mechanism or any
electronic components.

Deleting the EPSON Control Panel for windows

If you need to delete the EPSON Control Panel for Windows,
do the following:

1. Turn on the computer and start Windows.

2. From the Program Manager, choose Run in the File menu.
This brings up the Run dialog box.

3. Inthe Command Line text box, type C:\EPPRT\EPDELETE.
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Note:

If you installed the EPSON Control Panel in a directory other
than the default EPPRT directory, be sure to specify the correct
pathname.

4. When you are asked if you want to delete the EPSON
Control Panel, choose OK

5. Once the EPSON Control Panel is deleted, a message
appears telling you to delete EPDELETE.EXE. Choose OK.

6. Use the File Manager to delete the C:\EPPRT directory.
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Paper

Paper specifications

Note:
Since the quality of any particular brand or type of paper may be changed by the
manufacturer at any time, EPSON cannot guarantee the use of any particular

brand or type of paper. Always test samples of paper stock before purchasing large
quantities or printing large jobs.

Paper types: 2 Plain paper
Q  Special paper
QLabels
Q Envelopes
QJ Transparencies
& Colored paper

Paper weight: Plain paper: 16 to 24 Ib, 60 to 90 g/m’
card stock: 24 to 32 Ib, 90 to 120 g/m’
(manual feed only)

Paper size:

Paper: Type Size
Letter 8.5 x 11 inches
Legal 8.5 x 14 inches
Executive 7.25 x 10.5 inches
A4 210 mm x 297 mm

Envelope: B5 176 mm x 250 mm
Monarch 37/8 x 7 1/2 inches
Commercial 10 41/8 x 9 1/2 inches
DL 110 mm x 220 mm
C5 162 mm x 229 mm

Caution:
Do not load any size of paper other than those listed above.

Printable area: 4 mm from paper edge
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Puper feed

Paper feed
alignment and
direction:

Paper feed:

Paper tray supply
(20 Ib paper):

Paper eject:

Exit tray capacity
(20 Ib paper):

Printer

General

Printing method:

Resolution:

Printing speed:

Warm-up time:

Internal emulation:

Resident fonts:

CPU:
RAM:

Center alignment for all sizes

Automatic or manual feed

100 sheets
5-10 envelopes, depending on thickness

Face down

50 sheets

Laserbeam scanning and dry
electrophotographic  process

300 x 300, 600 x 600 dpi, switchable

Up to 4 pages per minute depending on the font
and quantity of data

Approximately 45 seconds
HP LaserJet 4P emulation

35 Intellifont, 10 TrueType for PCL 5¢°
(See Chapter 1 for a list of resident printer fonts.)

Intel 80960SA, 16 MHz
2M8 expandable up to 18MB
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Environmental

Temperature:
Humidity:

Altitude;

Mechanical

Dimensions and
weight:

Durability:

Electrical

Voltage:

Rated frequency:

Rated current

Powver:

safet
standards:

Laser radiation
regulations:

Elm

Operation: 5 to 35° C (42 to 95° F)
Storage:  -20 to 40° C (-1 to 104° F)

Operation: 15 to 85% RH
Storage: ~ 5to 95% RH

2500 meters (8200 feet) maximum

Height: 10.5 inches (265 mm)

Width: 13 inches (330 mm)

Depth:  9.25 inches (235 mm)

Weight: Approx. 11 Ib (5 kg) including the
toner cartridge.

5 years or 100,000 sheets, whichever comes first

90 Vto 132 V
50 Hz to 60 Hz + 3 Hz
Approximately 3.2 amps

Approximately 400W
Powers down to less than 30W in power save
mode

UL 1950
CSA 22.2 No. 950 Deviation 3

FDA (NCDRH) class |

FCC Part 15 Subpart B, Class B
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Toner cartridge

Model number: S051023

Storage 0to35°C(32t0 95° F)

temperature:

Storage humidity: 15 to 85% RH

Shelf life: 24 months after production

Life: Up to 4000 pages under the following conditions:

Letter-size paper, continuous printing, and
5% print ratio.

The number of pages you can print with a toner cartridge varies
depending on the type of printing. If you print a few pages at a time or
print dense text exceeding the 5% print ratio, your cartridge may print
fewer pages. The 5% print ratio is equivalent to double-spaced standard
text.

You can increase the life of the toner cartridge by using toner saving
mode.
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Interface

The parallel interfface connector pin assignments and a description of the
interface signals are shown in the table below.

Sjgna| Return _ o
Pin Pin Signal Direction | Description

1 19 STROBE IN STROBE pulse to read data.
Pulse width must be at least
0.5 ps at the receiving
terminal.

2 20 DATA 1 IN These signals represent

3 21 DATA 2 IN parallel data bits 1 to 8.

4 22 DATA 3 IN respectively. Each signal is at

5 23 DATA 4 IN HIGH level when data is

6 24 DATA 5 IN logical 1 and LOW when it is

7 26 DATA 6 IN logical 0.

8 26 DATA 7 IN

9 27 DATA 8 IN

10 28 ACKNLG ouTt About a 1-10-ps pulse width.
LOW indicates data has
been received and the
printer is ready to accept
mare data.

1 29 BUSY ouTt A HIGH signal indicates that
the printer cannot receive
data. The signal goes HIGH in
the following cases:

1. During printing
2. During a printer-error  state

12 30 PE ouTt A HIGH signal indicates the
printer is out of paper.

13 — SLCT ouT Pulled up to +5V through
33K resistance.

14 — AUTO IN Not used

FEED

15 - NC — Natured

16 — GND — Logic ground level

17 —_ CHASSIS - Printer’'s chassis ground,

GND which is connected to the
signal ground.

18 - NC —_ Not used
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Signal | Return

Pin Pin Signal Direction | Description
19-30 - GND — Twisted-pair return signal
ground level.
31 - NC — Not used
32 - ERROR Out This signal level goes LOW

when the printer is:
1. Out of paper
2. In an error state

33 — GND — Same as for Pins 19-30

34 — NC — Not used

35 — +5V —_ Pulled up to +5 V through
3.3 Kq resistance.

36 — SLCTIN IN Available only for

bidirectional use.

Note:

Q Allinterface conditions are based on TTL level. Both the rise and fall times of
each signal must be less than 0.2 microseconds.

O Data transfer must be carried out by observing the ACKNLG or BUSY
signal. (Data transfer to this printer can be carried out only after receipt of
the ACKNLG signal or when the level of the BUSY signal is LOW.)

3 The column heading “Direction” refers to the direction of signal flow as
viewed from the printer.

Q  Return denotes the twisted-pair return to be connected at signal ground
level. For the interface wiring, be sure to use a twisted-pair cable for each
signal and to complete the connection on the return side.

Q The ACKNLG pulse width varies.
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EPSON Control Panel for DOS

If you are not running Microsoft Windows, you can control printer
settings through the EPSON Control Panel for DOS. This onscreen utility
consists of five screens that allow you to do the following:

3 Change page setup settings, such as the number of copies,
orientation, and page size.

3 Select a font, point size, or symbol set.

3 Control the print quality by specifying the edge smoothing, toner
saving, resolution, and toner density settings.

3 Control how printer memory is used for page protection.

Q Turn the power save option on or off and specify how long the
printer is idle before power save mode turns on.

Most of the settings available in the EPSON Control Panel for DOS are
the same as the printer driver settings available for Widows. For a
description of the individual printer settings, see Chapter 2.

Some settings, such as those for page setup and font selection, are also
available through your software program Whenever possible, change
settings in yours software program rather than in the EPSON Control
Panel for DOS. Not only is it more convenient, but the settings in your
software program override settings in the EPSON Control Panel for DOS.

Note:
You cannot run the EPSON Control Panel for DOS from Windows.

Installation

1. Insert the EPSON Control Panel for DOS diskette in a diskette drive.

2. From a DOS prompt, change to the diskette drive by typing A: or B: as
appropriate. Press Enter.

3. Type SETUP and press Enter. After a few moments, the initial setup
screen appears.

4. Read the information on the setup screen. Then press Enter to
continue.
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5. The screen displays the default setup parameters that are designed to
be used for most computer environments. If the default parameters
are acceptable and you don’'t need to make any changes, press Enter.

If you need to make changes, tab to Noand press Enter. This brings
up a series of screens, each of which prompts you to change a setting.
For each setting, press Enter to accept the default or change the
setting and press Enter. The setup program begins uncompressing
files and copying them to your hard disk.

6. When a message appears telling you that installation was successful,
press Enter to exit the setup program.

This completes installation of the EPSON Control Panel for DOS.

To use your printer, select the HP LaserJet 4P printer driver in your
software program. If this driver is not available, contact your software
manufacturer for an updated version of the software program. Until you
receive the new version, you can use any LaserJet Il driver or any driver
that uses HP PCL.

See your software manual for specific information on how to select a
printer driver.

Bringing up the EPSON Control Panel for DOS

To bring up the EPSON Control Panel for DOS, do the following:
1. At a C: prompt, change to the PANEL directory by typing
CD\PANEL. Then press Enter.

Note:
If you installed the EPSON Control Panel to a different directory than the
default, be sure to specify the correct pathname.

2. Type PANEL and press Enter.
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Using the EPSON Control Panel for DOS

The interface for the EPSON Control Panel for DOS consists of three parts:
the current screen, a menu bar, and buttons for accessing other screens.

EPSON Control Panel screens

The EPSON Control Panel for DOS consists of five screens: Page Setup,
Font, Quality, Memory, and Options. One screen is displayed at a time,
and the other screens are represented by buttons to the left of the current

screen.
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The five screens are listed below, along with the items available on each.

Menu Item

Page Setup copies

tines per Page
Orientation
Paper Feed
Paper Size
Auto Continue

Font Typeface
Pitch
Symbol Set

Quality Toner Saving
Edge Smoothing
Resolution

Toner Density

Memory Page Protection

Options Power Save
Power Save interval

Moving within and between screens

When you first bring up EPSON Control Panel for DOS, the Page Setup
screen is displayed. If you have mouse capability, you can simply point
and click to access settings in the current screen or move to another screen.

If you're using the keyboard and you want to change an item in the
current screen, use the Tab key to move to the item you want to change.
Then use the up and down arrows to select a new setting for the item.
Press Tab to apply the new setting and move to the next item.

To access another sawn, hold down the Alt key and press the letter that
is underlined on the screen button. For example, to open the Font screen,

press Alt + N. To move from the screen button to the currently displayed
screen, press Tab.

Once you make changes to the settings, choose OK to save the changes
and update the printer. To cancel your changes and return to the original
settings, choose Cancel. (If you exit the screen without choosing OK or

Cancel, you are prompted to save or to cancel changes when you exit the
EPSON Control Panel.)

Controlling Printer Settings from MS-DOS  B-5




Menu bar

The menu bar contains the following four menus:

File The File selections allow you to exit the utility,
save printer settings as a profile, retrieve a
previously saved profile, and export a profile to
the printer. For more information about profiles,
see the following section.

View Choosing View brings up a listing of the current
printer settings.

Utility The Utility selections allow you to reset the
printer, change the port setting, and print a test
page, status sheet, and demonstration page

Help The Help menu contains the Help index and the
About item.

To access a menu using the keyboard, hold down the Alt key while you
press the first letter of the name of the menu (e.g., press Alt + F to bring
up the File menu). Use the up and down arrows to select an item on the
menu. Then press Enter.

Help is available for each item in the menu bar. To bring up help, move
the cursor to the item and press F1.

To move the cursor from the menu bar to the screen, press ESc.

Getting help

The status bar at the bottom of the screen provides a brief description for
each setting. For more information about the current setting, press F1.

You can also bring up the Help Index in the menu bar, which allows you
to get help for any EPSON Control Panel item. To bring up the Help Index
using the keyboard, press Alt + H, then press Enter. Use the up and down
arrows to move through the list of items When you reach the item for
which you want help, press Enter.
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Using profiles

A profile is a specific set of printer settings. If you often re-use the same

printer settings, you can create a profile to easily update your printer with
predefined settings.

There are three ways to create a profile:

Q Use the EPSON Control Panel for DOS to change the printer settings
as needed. Then choose Save Profile in the File menu. This brings up
a dialog box that prompts you to assign a filename and choose the
directory in which to stare the profile. When you complete the
information in the dialog box, choose OK.

Q  Open an existing profile and modify the settings of the profile. To do
s0, use Open Profile in the File menu to open an existing profile.
Change just those settings that you want to change and then choose
Save As in the File menu Enter a new filename and choose the
directory in which to save the profile.

3 Use the settings currently in use by the printer to create a profile. To
do so, choose Import Profile From Printer in the File menu. This
brings up a dialog box that prompts you to name the profile and
choose the directory in which to store it.

When you open a profile, you can export the printer settings described by
the profile by using the Export Profile to Printer item on the File menu

Reporter

The Reporter keeps you informed of the printer status and alerts you to
printer problems. Each time the printer status changes or an error occurs,
a message automatically appears on screen to notify you Each Reporter
message gives you the option of disabling the particular message so that it
does not reappear until you re-enable it.

To load the Reporter.
1. Change to the PANEL directory by typing CD PANEL.
2. Type REP.
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Once the Reporter is loaded, you can modify its operating parameters.
Use the hot key combination Ctrl + Alt + R to bring up the Reporter's
main menu. The main menu allows you to do the following:

Q

Q

Q

Q

Q

A help option on the menu provides a brief explanation for each topic on

Enable messages that you have disabled.
Review the last message displayed by the Reporter.

Deactivate (or re-activate) the Reporter. When the Reporter is
deactivated, it does not monitor the printer and does not display
messages.

Change the hot key combination used to bring up the Reporter’s
main menu.

Change the colors of the Reporter’s messages.

the main menu.
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LJ4P Emulation Commands

Your printer emulates the Hewlett-Packard LaserJet 4P (LJ4P) printer and
uses the PCL Se command language:

This appendix lists the available printer commands for LJ4P emulation.
Most of the commands closely emulate the original printer or the control

language; however, some have operational differences.

The following notes apply to various commandsin the following
command summary:

1. These commands are specific to the EPSON ActionLaser 1400.

2. Secondary printer commands are specified as secondary by using a right parenthesis")" in the
command in stead of a left parenthesis.

Function

Job control

Reset ESC E
Number of ESC &/ #x
copies

Universal exit ESC %- #x
language

Long-edge ESC &/ #U
(left) offset
registration
Short-edge ESC &/ #Z

(top) offset
registration

Unit of measure ESC &u #D

Page control

paper source ‘ESC &/ OH

command Parameter

#=1-99
x11-5

# = number of
decipoints (1/720%)

# = number of
decipoints (1/720%)

# = No. of units
per inch

Eject page

ESC &/ 1H Standard tray

ESC &/ 2H
ESC &/ 3H

Manual feed

Manual envelope
feed

Decimal value

027 069
027 038 108 #..# 088

027 030 108 #..# 085

027 038 108 #..# 090

027 038 117 #..# 068

027 038 108 048 072
027 038 108 049 072
027 038 108 050 072
027 038 108 051 072

Hexadecimal value

1B 45
1B 26 6C #.# 58

1B 26 6C #..# 55

1B 26 6C #..# 5A

1B 26 75 #..# 44

1B 26 6C 30 4B

1B 26 bC 31 48

1B 26 6C 32 48
1B 26 6C 33 48
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Function Command
Page size * ESC & 1A
ESC &/ 2A
ESC & 3A
ESC &/ 26A
ESC &/ 80A
ESC &/ 81A
ESC &/ 90A
ESC & 91A
ESC & 100A
ESC & 101A
Page length ESC &/ #P
Orientation ESC & 00
ESC &/ 10
ESC &/ 20
ESC &/ 30
Print direction ~ ESC &a#P
Top margin  ESC &/ #E
Text length ESC &/ #F
Left margin ESC &at#flL
Right margin ESC &a#M
Clear ESC 9
horizontal
margins
Perforation ESC & OL
skip ESC & 1L

Horizontal ESC &k#H
motion index
(HMI1)

Vertical motion ESC &/ #C
index (VMI)

Line spacing ESC &/ 1D
ESC &/ 2D
ESC & 3D
ESC & 4D
ESC &/ 6D
ESC &/ 8D

ESC & 12D

Parameter
Executive
Letter

Legal

Ad

Monarch

COM 10
International DL
International  C5
International B5
Custom

# = No. of lines
(5-128)

Portrait
Landscape
Reverse Portrait

Reverse Landscape

# = Degrees of
rotation counter
clockwise in 90°
increments

# = No. of lines
# = No. Of lines
# = No. of columns
# = No. of columns

Disable
Enable

# = No. of 1/120"
increments

# = No. of 1/48"
increments

1 line/inch

2 lines/inch
3 lines/inch
4 lines/inch
6 lines/inch
8 lines/ inch
12 lines/inch

Decimal value

027 038 108 049 065

027 038 108 050 065

027 038 108 051 065

027 038 108 060 054 065
027 038 108 056 048 056
027 038 056 049 065
027 038 108 057 048 065
027 038 108 057 049 065
027 038 108 049 048 048 065
027 038 049 048 049 065
027 038 108 #..# 080

027 038 108 048 079
027 038 108 049 079
027 038 108 050 079
027 038 108 051 079
027 038 097 #...# 080

027 038 108 #...# 069
027 038 108 #..# 070
027 038 097 #..# 076
027 038 097 #..# 077
027 057

027 038 018 048 076
027 038 108 049 076
027 038 107 #..# 072

027 038 108 #..# 067

027 038 108 049 068
027 038 108 050 068
027 038 108 051 068
027 038 108 052 068
027 038 108 054 068
027 038 108 056 068
027 038 108 049 050 068

Hexadecimal value
1B 26 6C 31 41

1B 26 6C 32 41

1B 26 6C 33 41

1B 26 6C 32 36 41
1B 26 6C 38 30 41
1B 26 6C 38 31 41
1B 26 6C 39 30 41
1B 26 6C 39 31 41
1B 26 6C 31 30 41
1B 26 6C 31 30 31 41
1B 26 6C #...# 050

1B 26 6C 30 4F
1B 26 6C 31 4F
1B 26 6C 32 4F
1B 26 6C 33 4F
1B 26 61 #...# 50

1B 26 6C #..# 45
1B 26 6C #..# 46
1B 26 61 #..# 4C
1B 26 61 #..# 4D
1B 39

1B 26 6C 30 4C
1B 26 6C 31 4C
1B 26 6B #..# 48

1B 26 6C #..# 43

1B 26 6C 31 44
1B 26 6C 32 44
1B 26 6C 33 44
1B 26 6C 34 44
1B 26 6C 36 44
1B 26 6C 38 44
1B 26 6C 31 32 44
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Function Command Parameter Decimal value Hexadecimal value

ESC&f 16D 16 lines/inch 027 038 108 049 054 068 1B 26 6C 31 36 44
ESC&f 24D 24 lines/inch 027 038 108 050 052 068 1826 6C 22 34 44
ESC&f 485D 48 lines/inch 027 (08 108 052 056 068 1B 26 6C 3438 44
Cursor positioning
Vertical ESC&s#R  #=No.ofrows 027 (38097 4.4 082 1B 26614..4 52
position ESC'p#Y  #=No.ofdos 02 0421120.4089 1B2ATLND
ESC&a#V  #=No.of decipoints 027 (38 097 #...# 086 1826 614..4#56
Horizontal ~ ESC&a#C  #=No.of columns 027 038 097 4...4 067 1826614443
position ESC*p#X  #=No.of dots 02 042112 4..4 088 " 1B2A7D R4 S8
ESC&a#H  #=No.of decipoints 027 08 097 #..#072 1B2661 #.448
Halflinefeed ESC= - 027 061 183D
Line ESC&kOG  CR=CR;LE=LF; 027 (38107 048071 1B266B 3047
termination FF=FF
ESC&KIG  CR=CR+LF;LFLF; 027 (88107 049071 1B 26 6B 3147
FFaFF
ESC&K2G  CR=CR;LF=CR+LF; 027 (38 107 050071 1B266B3247
FF=CR+LF
ESC&K3G  CR=CR+LF; 027 038 107 051 071 1B 2668 33 47
LF=CR+LF;
FF=CR+FF
Push/Pop  ESC&RS  Push 027 038 102 048 063 1B 26 66 30 53
position ESC&fIS  Pop 027 038 102 049 083 1B 26 66 31 53
Font selection
mmz ESC (0D ISO 60: Norwegian 1 027 040 048 068 16283044
ESC(1E 1SO & United 027 040 049 069 1B 283145
lom
ESC (5E Windows 3.1Latin 2 027 040 057 069 1B 283945
ESC(IF 1SO 69: French 027 040 049 070 1B 283146
ESC(1G ISO21:German 027 040 049 071 1B283147
ESC (0 ISO 15: Italian 027 040 048 073 1B 283049
ESC (6} Microsaft Publishing 027 040 054 074 1B 2836 4A
BSC (] DeskTop 027 040 055 074 18 28374A
ESC (10] PS Text 027 040 049 048 074 1B2831304A
ESC(12) MC Text 027 040 049 050 074 1828313244
ESC(13 Ventura 027 040 049 D51 074 1B2831334A
International
ESC (14 Ventura US 027 040 049 052 074 1B2831344A
ESC(S%L  Wingdings 027 040 053 055 057 076 1828353739 4C
ESC (SM PS Math 027 040 063 077 1B28354D
ESC (6M Ventura Math 027 040054 077 1B 28 36 4D
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Function Command Parameter Decimal value Hexadecimal value
ESC (8M Math-8 027 040 056 077 18 28 384D
ESC (19M Symbol 027 040 049 057 077 182831 94D
ESC (ON 1SO 88%9-1: 027 040 048 078 1B28304E
(ECMA-94) Latin 1
ESC (2N ISO8859-2: Latin2 027 040 050 078 182832 4E
ESC (SN 1ISO 8859-9: Latin9 027 040 053 078 1B 283S4E
ESC (08 1SO 11: Swedish 027 040 048 083 18283053
ESC (5 1SO 17: Spanish 027 040 050 083 18283253
ESC (ST Windows 3.1 Latin§ 027 040 053 084 1B 283554
ESC (97 PC Turkish 027 040 057 084 1B28395%4
ESC (0U 1ISO & ASCII 027 040 048 085 1B283055
ESC (1U Legal 027 040 049 085 1B 283155
ESC (8U Roman8 - 027 040 056 085 1B2838 S5
ESC (9U Windows 3.0 Latin 1 027 040 057 085 1B2839 55
ESC (10U PC8 027 040 049 048 085 1B283130 55
ESC (11U PC-8D/N 027 040 049 049 085 1B28 3131 55
ESC (U PC 850 027 040 049 050 085 18283132 S5
ESC (15U Pi Font 027 040 049 053 085 1828313553
ESC Q7U PC-852 027 040 049 0SS 085 1B283137 55
ESC (19U Windows 3.1 Latin1 027 040 049 057 085 1B2831% 55
(ANSI)
Primary ESC (s1P Proportional 027 040 115 049 080 18287331 0
spacing ESC(s0P Fixed 027 040 115 048 080 18287330 50
Primary pitch  ESC (s#H # = No. of 027040 115 4.4 072 1B28734..448
characters/ inch
Set pitch mode ESC &k0S 100 027 038 107 048 083 1B266B 30 3
ESC &k25 027 038 107 050 083 1B266BR 3
(165-16.7) )
ESC &k¢5 Elite (12.0) 027 038 107 052 083 1B266BM 53
Primary height ESC (s#V # = No. of points 027 040 115 #...# 086 1B28734..#56
Primary style ESC (a05 Upright (solid) 027 040 115 048 083 1B287330 S3
ESC (s1S Ttalic 027 040 115 049 083 1B287331 53
ESC (s4S Condensed 027 040 115 052 083 1B287334 83
ESC (s55 Condensed Italic 027 040 115 053 083 1828733553
ESC (s8S Compressed (Extra 027 040 115 056 083 1B287338 S3
Condensed)
ESC (s24S Expanded 027 040 115 050 052 083 1B287332 3453
ESC (s32S Qutline 027 040 115 051 050 083 1B287333 1253
ESC (s645 Inline 027 040 115 054 052 083 1B287336 M4 53
ESC (s1285 Shadowed 027 040 115 049 050 056 083 18287331 223853
ESC (s1605 Outline Shadowed 027 040 115 049 054 048 083 18287331 363053
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Command
ESC (s-78
ESC (s-6B
ESC (s-SB
ESC (s4B
ESC (s-3B
ESC (s-2B
ESC (s-1B
ESC (s0B

Function
Primary font
stroke weight

ESC (s1B
ESC (s2B
ESC(s3B
ESC (s4B

ESC (s5B
ESC (s6B
ESC(s7B
ESC (s4382T
ESC (s4168T
ESC (s4140T
ESC (s4116T
ESC (s3T
ESC (s4197T
ESC (s4102T
ESC (s4297T
ESC (s4113T
ESC (s101T
ESC (s4148T
ESC (s16602T
ESC (s16901T
ESC (s16686T
ESC (s31402T
ESC (3@

EsC e

ESC &d0D
ESC &d3D
ESC&d@

H

Font default

Undesline

Transparent

ESC
print data [Data]

Parameter
Ultra thin
Extra thin

Thin

Extra light
Light

Demi light
Semi light
Medium

(book or text)
Semi boid
Demi bold
Bold

Extra bold
Black

Extra black
Ultra black
Albertus
Antique Olive
Clarendon
Coronet
Courier
Garamond Antiqua
Letter Gothic
Marigold

CG Omega

CG Times
Univers

Arial

Times New Roman
Symbol
Wingdings
Primary font
Secondary font
Enable fixed
Enable floating
Disable

# = No. of bytes

Decimal value

027 040 115 045 055 066
027 040 115 043 054 066
027 040 115 045 053 066
027 040 115 045 052 066
027 040 115 045 051 066
027 040 115 045 050 066
027 040 115 045 049 066
027 040 115 048 066

027 040 115 049 066
027 040 115 050 066
027 040 115 051 066
027 040 115 052 066
027 040 115053 066
027 040 115 054 066
027 040 115 055 066

027 040 115 052 051 054 050 084
027 040 115 052 049 054 056 084
027 040 115 052 049 052 048 084
027 040 113 052 049 049 054 084

027 040 115 051 084

027 040 115 052 049 057 055 084
027 040 115052 049 048 050 084
027 040 115 052 050 057 055 084
027 040 115 052 049 049 051 084
027 040 115 052 049 048 049 084
027 040 115 052 049 052 056 084

Hexadecimal value
182873203742
1B28732D36 42
1B28732D3542
1828732D34 &2
1B28732D3342
1B28732D3242
1B28732D31 42
1828733042

1B2B73314
1B28733242
1B28733342
IB2B7334 4
1B28733542
1B287336 2
1828733742
1B28733433 363254
1B 28733431 363854
1B28733431343054
1B 2873343131 3654
1B28733454
1B28733431 393754
1828733431 303254
1B28733432 393754
1B 28733431 313354
1B 28733431 03154
1B 28733431 343854

027 040 115049 054 054 048 050084 1B 28 73 31 36 36 30 32 54
027 040 115049054 057 048 049084 1B 287331 36 39 X031 54
027 040 115049 054 054 056 054 084 1B 28 73 31 36 36 38 36 54
027 040 115051 049 052 048050084 1B 2873333134 0254

027 040 051 064
027 041 051 064
027 @38 100 048 068
027 138 100 051 068
027 (38 100 064
027 38 112 #..# 088

18283340
18293340
1B26 6430 4
1B266433 4
1B 26 64 40
1B2670#..458
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Function

Command

Parameter

Font management

Assign fort ID  ESC *o#D
Font and ESC *«OF
character
contzal ESC *c1F
ESC *c2F
ESC *3F
ESC *c4F
ESC *c5F
ESC *c6F
Set symbol set ESC *c#R
Define symbol ESC (f#W
set [Data}
Symbol set ESC *c0S
control
ESC *c1S
ESC *c2S
ESC *c4S
ESC *c58
Select font ESC (#X
(with ID#)
ESC WX
Soft font creation

Font descriptor ESC )s#W
(font header) [Data]

ESC (stW
character [Data]

Character code ESC *c#E

# = Font ID number
Delete all fonts

Decimal value

027 042 099 4...# 068
027 042 099 048 070

Delete all tempocary 027 042 099 049 070
fonts

Delete last font ID
ified

Delete last character
specified

Make font
temporary

" Make font

permanent

Copy/assign the
currently invoked
font as temporary

ID#
# = Bytes

Delete all symbol
sets

Delete all temporary
symbol sets

Delete current soft
symbol set (last [D#)
Make current soft
symbol set
temporary

Make current soft
symbol set
permanent

# = ID number for
primary font

# = [ID number for
secondary font

# = No. of bytes
# = No. of bytes

# = Character code
(decimal)

027 042 099 050 070

027 042 099 051 070

027 042 099 052 070

027 042 099 053 070

027 042 099 054 070

027 042 099 #...# 082

027 040 102 #...# 087

027 042 099 048 083

027 042 099 049 083

027 042 099 050 083

027 042 099 052 083

027 042 099 053 083

027 040 #...4 088

027 041 #...# 088

027 041 115#..#087

027 040 115 #...# 087

027 042 099 #...# 069

Hexadecimal value

1B2A6G3#..#44
1B2A 633046
1B2A 633146

1B2A 633246
1B2A 633346
1B2A 633446
1B2A 633546
1B2A 63 36 46
1B2A 63 4..#52
1B28 66 #...# 57
1B2A 633053
1B2A 633153
1B2A 633253

1B2A 633453

1B2A 633553

1B28#..#58

1B29#..#58

1B2973#.457
1B2873#..457

1B2A634..#45
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Function Command  Parameter Decimal value Hexadecimal value
Raster graphics
Raster ESC *175R 75 dots/inch 027 042 116 055 053 082 1B 2A 74 37 3552
ution ESC *t100R 100 dots/inch 027 042 116 049 048 048 082 1B2A 74313030 82
ESC *t150R 150 dots/inch 027 042 116 049 053 048 082 1B2A 74313530 %2
ESC *t300R 300 dots/iinch 027 042 116 051 048 048 082 1B2A 74 333030 R
ESC *t600R 600 dots/inch 027 042 116 054 048 048 082 1B2A 74 36 3030 R2
Raster graphics ESC *r0F Follows onientation 027 042 114 048 070 1B 2A 72 30 46
Presentation o e3F  Followsphysical 027 042 114 051070 1B2A72 B 46
page
Start raster ESC*r0A Left raster graphics 027 042 114 048 065 1B2A 72 0 41
graphics margin
ESC*rlA -Current cursor 027 042 114 049 065 1B 2A 72 31 41
Raster Y offset ESC *b#fY # = No. of raster 027 042 098 #...# 089 1IB2A G 4.5
lines of vertical
movement
Setl'ntcl'~ ESC *b0M Unencoded 027 042 098 048 077 1B2A 62 204D
o f  ESC*HIM  Run-Length encoded 027 042 098 049 077 1B 2A 62 314D
ESC "*b2M Tagged imagefile 027 042098 050 077 1B2A 2 24D
format
ESC *b3M Delita row 027 042 098 051 077 1B2A 2 334D
ESC *bSM Adaptive 027 042 098 053 077 1B2A &2 354D
compression
Transfer raster ESC # = No. of bytes 027 042 098 #...# 087 1B2A G2 #. .45
data “H¥W(Data]
End raster ESC*rB Old version 027 042 114 066 1B2A72 @2
Graphics ESC*rC Preferred 027 042 114 067 1B2A72 8
Raster graphics ESC *t#T # = No. of raster 027 042 114 #_.# 084 1B2A2#.4#54
height rows
Raster graphics ESC *#S # = Pixels of the 027 042114 #..4 0683 1B2A 2 #.453
width specified resolution
Print model
Select current  ESC *vOT Salid black (default) 027 042 118 048 084 1B2A 76 30 54
pa ESC*1T Salid white D27 042 118 045 084 1B 2A 76 31 54
ESC*v2T HP-defined 027 042 118 050 084 1B2A 76 254
shading pattern
ESC *v3T HP-defined 027 042 118 051 084 1B 2A 76 33 54
cross-hatch pattern
ESC *v4T User-defined pattern 027 042 118 052 084 1B2A 76 34 54
Select source  ESC *vON Transparent 027 042 118 048 078 1B2A 76 0 4E
m"“m""'"“’ ESCWIN  Opaque 027 042 118 049 078 1B2A 76 31 4E
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Function

Select pattern

transparency
mode

width

Rectangie
height

Fill rectangular

Pattern ID

Shading

Pattern

Define pattern

User-defined
pattern control

Command
ESC 00
ESC 10

ESC *cWA
ESC *c#H
ESC *c#B
ESC *c#V
ESC *cOP
ESC *c1P

ESC *2P
ESC *c3P
ESC *ctP
ESC *c5P

ESC *c#G

ESC *c2G
ESC "c10G
ESC *c15G
ESC *c30G
ESC *c45G
ESC *c70G
ESC *90G
ESC *100G
ESC *1G

nes soas
[ S =2 @)

ESC 3G
ESC *cd4G
ESC “c5G
ESC *c6C

ESC ‘o'W
[Data]

ESC *c0Q
ESC *1Q

ESC *2Q
ESC *c4Q

ESC *c5Q

Parameter Decimal value
Transparent 027042 118 048 079
Opaque 027 042 118 049 079
# = No. of dots 027 042 099 #...# 065
# = No. of decipoints 027 042 099 #...# 072
# = No. of dots 027 042 099 #...# 066
# = No. of decipoints 027 042 099 #...¢ 086
Solid Black 027 042 099 048 030
Erase (solid white 027 042 099 049 080
area fili}

Shaded fll 027 042 099 050 080
Cross-hatch £ll 027 042 099 051 080
User-defined 027 042 099 052 080

% of shading or type 027 042 099 #...# 071

N7 Nan Mo 2 Non
Vs Ve Y77 UWos vou

Hexadecimal value

1B 2A 76 30 4F
1B2A 76 31 4F

1B2A83 4. 441
1B2AG3#..#48
1B2A6348..442
1B2A 63 #..#56
1B2A 633050
1B2A 633150

1B2A 633250
1B2A 633350
1B 2A 63 34 50

1B A 23 3B EN
AV &N O3 ST oV

o
1B2A G3 W..#47

of patierm or user
pattern ID
2% gray 027 042 099 050 071 1B2A 633247
10% gray 027 042 099 049 048 071 1B2A 6331304
15% gray 027 042 099 049 053 071 1B2A 63313540
30% gray 027 042 099 051 048 071 1B2A 63333047
45% gray 027 042 099 052 053 071 1B2A 6334354
70% gray 027 0&2 055 G55 048 071 iIB2AG3730 4
90% gray 027 042 099 057 048 071 1B2A 6339304
100% gray 027 042 099 049 048 048 071 1B2A633130X
1 horiz. line 027 042 099 049 071 1B2A 633147
2 vert lines 027 042 099 050071 1B2A 633247
3 diagomal lines 027 042 099 051 071 1B2A 633347
4 diagonal lines 027 042 099 052 071 1B2A 633447
5 square grid 027 042 099 053 071 1B2A 633547
6 diagonal grid 027 042 000 054 071 1B2A 633647
User-defined pattem/management creation
#= No. of bytes 027 042 099 4...# 087 1B2A 63 #..457
Delete all patterns 027 042 099 048 081 1B2A 63030 51
Delete all temporary 027 042 099 049 081 1B2A 63031 51
patterns
Delete current 027 042 099 050 081 1B2A 63032 51
pattern
Make pattern 027 042 099052 081 1B2A 63034 51
temporary
Make pattern 027 042 099 053 081 1B2A 63035 51
permanent
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Function

Macros

Macro ID

Macro control

Status readback

Set status

location type

Set status
readback
location unit

Inquire status
readback entity

Command Parameter

ESC &f#Y
ESC &f0X
ESC &f1X
ESC &f2X
ESC &£3X
ESC &fdX
ESC &fS5X
ESC &f6X
ESC &I7X

ESC &f8X
ESC &9X
ESC &f10X

ESC *s0T
ESC*s1T
ESC*s2T
ESC *s3T
ESC *s4T
ESC*sST
ESC *s7T

ESC *s0U

ESC *s1U
ESC*s2U

ESC *s3U
ESC*s4U
ESC*s0l
ESC *sli
ESC *s2l
ESC*s31
ESC*sdl

Flush all pages ESC &rOF

ESC &r1F

#=Macro ID number
Start macro def.
Stop macro def.
Execute macro

Enable overlay
Disable overlay

Delete all temp.
macros

Delete macro ID
Make temporary
Make permanent

Invalid location
Currendly selected
All locations
Internal
Downloaded

User-installed
ROM (SIMMs)

All entities of the
Location Type

Entity 1or
Temporary

Entity 2 or
Permanent

Entity 3
Entity 4
Font
Macro

Decimal value

027 038 102 #...# 089
027 038 102 048 088
027 008 102 049 088
027 038 102 050 088
027 038 102 051 088
027 038 102 052 088
027 038 102 053 088
027 038 102 054 088
027 038 102 055 088

027 038 102 056 088
027 038 102 057 088

027 038 102 049 048 088

027 042115 048 084
027 042 115 049 084
027 042 115050 084
027 042 115 051 084
027 042 115052 084
027 042 115053 084
027 042 115055 084

027 042 115 048 085

027 042 115 049 085

027 042 115 050 085

027 042 115 051 085
027 042 115 052 085
027 042 115 048 073
027 042 115049 073

User-defined pattern 027 042 115 050 073

Symbol set
Font extended

Flush all complete
pages
Flush all page data

027 042 115051 073
027 042 115052 073
027 038 114 048 070

027 038 114 049 070

Hexadecimal value

1B 2666 #..# 59
18 26 66 30 S8
1B 26 66 31 58
1B 26663258
1B 2666 33 58
1B 266634 58
1B 26 66 35 S8
1B 2666 3658
1B 26 66 37 58

1B 2666 38 58
1B 26 66 39 58
1B 26 66 31 X0 S8

1B2A 73 054
1B2A 73 3154
1B2A73 254
1B2A 73 33 54
1B2A 73 3454
1B2A 733554
1B2A 73 37 54

1B2A 732055

1B2A 73 31 55

1B2A 73 3255

1B2A73 S5
1B2A 73 34 55
1B2A 73 20 49
1B2A 7331 49
1B2A73 249
1B2A 7333 49
1B2A 73 34 49
1B 26723046

1B 26723146
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Function Command Parameter Decimal due Hexadecimal value

Programming hints

End of line ESC &s0C Enabled 027 038 115 048 067 12673083
wrap

ESC &s1C Disabled 027 038 115 049 067 1B267331 83
Display ESCY ON 0T 089 1BS9
functions

ESCZ OFF 027 0%0 1B5A
Nondisclosed ESCz Self test
command

Vartnr rrrarnhine
vV wiws ,'Wl S

Enter GL/2 ESC %0B Use previous GL/2 027 037 048 066 18253042

ESC %18 Use current PCL 027 037 049 066 18253142
cursor position

GL/2 ESC *c#K # = Horizontal size 027 042 099 #..# 075 1B2A 63 #4..# 4B

emulation plot in inches

horizontal size

GL/2 ESC *oiL #= Vertical size in 027 042 099 #..# 076 1B2A 63#..44C

emulation plot inches

vertical size

Set picture ESC *0T Set anchor point to 027 042 099 048 084 1B2A 633054

frame anchor CAP

paint

Picture frame  ESC *c#X # = Decipaints 027 042 099 #...4 088 1B2A 63 4..#58

horizontal size

Picture frame  ESC *c¥Y # = Dedipoints 027 042 099 &...# 089 1B2A 63 #..#59

vertical size

Control codes

Backspace BS

Line feed LF’

Form feed FF
Carriage return CR

Shift in s1 Select primary font
Shift out SO Select secondary font
Horizontal tab HT

Escape ESC

Space sp
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Function Command

GL/2 emulation context commands

Dual context extension

Enter PCL mode ESC 9%#A
Reset ESC E
Primary font (standard font) A
Secondary font (alternate font) FN
Scalable or bitmap font SB

Configuration and status group

Input P1 and P2 P
Input relative P1 and P2 IR
Scale SC
Input window [\
Rotate coordinate system RO
Initialize IN
Default values DF
Comment co
Line and fill attributes group
Lint attributes LA
Line type LT
User defined line type UL
Select pen SF
Pen width PW
Pen width unit selection WU
Fill type FT
Screened  vectors SV
Raster fill definition RF
Anchor corner AC
Symbol mode SM
Transparency mode TR
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Function

Vector group

Pen down

Pen up

plot absolute

Plot relative

Arc absolute

Arc relative

Absolute arc three point
Relative arc three point
Polyline encodeed
Bezier absolute

Bezier relative

Polygon group
Grele

Edge rectangle absol ute
Edge rectangle relative
Fill rectangle absolute
Fill rectangle relative
Edge wedge

Fill wedge

Pol ygon mode

Edge pol ygon

Fill polygon

Character group

Standard font definition
Alternate font definition
Select standard font
Select alternate font
Absolute direction
Relative direction
Absolute character size
Relative character size
Character slant
Character fill mode
Label

Define label terminator

Command

PD
PU
PA
PR

AA
AR
AT
RT
FE

BZ
BR

EA
ER
RA
RR
EW
WG
PM
EF
FF

SD
AD
SS
SA
DI
DR
S
SR
SL
CF
LB
DT
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Function Command

Label origin Lo
Define Variable text path w
Extra space Es
character plot cP
Transparent data TD
Define variable text path w
PJL Mode

This section lists the available commands for the Printer Job Language

(PIL)

Function Command

COMMENT @ PJL COMMENT <words> [<CR>] <LF>
DEFAULT @ PJL DEFAULT [LPARM] [<(CR>] <LF>
DINQUIRE @ PIL DINQUIRE [LPARM] [<CR>] <LF>

ECHO @ PJL ECHO [Words] [<CR>] <LF>

ENTER @ PIL ENTER LANGUAGE = **[<CR>] <LF>
EQJ @ PJL EOJ [NAME = job name] [<CR>] <LF>

INFO @ PIL INFO read only variable [<CR>] <LF>
INITIALIZE @ PIL INITIALIZE [<CR>] <LF>

INQUIRE @ PJL INQUIRE [LPALM] VARIABLE [<CR>] <LF>
JoB @ PJL JOB [NAME = job name] [Start = first page] [<CR>} <LF>
OPMSG @ PJL OPMSG DISPLAY = message [<CR>] <LF>
RDYMSG @ PJL RDYMSG DISPLAY = message [<CR>] <LF>
RESET @ PIL RESET [<CR>] <LF>

SET @ PIL SET [LPARM] [<CR>] <LF>

STMSG @ PJL STMSG DISPLAY = message [<CR>] <LF>
UEL/SPJL <ESC>%-12345X

USTATUS @ PJL USTATUS variable = VALUE [<CR>] <LF>
USTATUSOFF @ PIL USTATUSOFF [<CR>] <LF>

PIJL @ PJL [<CR>] <LF>
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Appendix D
Installing Additional Memory

Memory Module . . . . .. ... D-2
Installing SIMMs . . . . . . . .o D-2
Checking the memory . . .. ................. D-4
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Memory Module

By installing one or two 1IMB, 2MB, 4MB, or 8MB Single In-Line Memory
Modules (SIMMSs), you can increase printer memory up to 18MB. You
may want to add additional memory if you are having difficulty printing
complex, graphics-intensive pages or if you regularly use many
downloaded fonts.

You can purchase SIMMs from various vendors. Be sure the SIMMSs you
purchase meet the following requirements:

Q  72-pin type
O Capacity of 1, 2, 4, or SMB

Q  Access speed of 70ns or less

Installing SIMMs

\ Warning
High voltages are present inside the printer when the power is on. Do not
attempt to install a SIMM unless the printer is turned off.
1. Turn off the printer and unplug the power cable from the electrical outlet.
2. Turn the printer so the back of the printer is facing you.

3. Use a crosshead screwdriver to remove the five screws that secure the
metal access cover as shown below. Lift off the access cover.

//
4
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4.

© © N o O»

10.
11.

12.
13.

14.

\ Warning:

M Avoid touching the electrical components that are exposed after you
remove the metal access cover. They may be very hot if the printer
has been used recently.

Press the SIMM firmly in one of the slots until it snaps into place.

3|

[

S

© watieb N W

If you have a second SIMM, press it into the remaining slot.
Replace the metal access cover.

Reattach the power cord.

Switch on the printer's power.

Now you need to update the printer driver’s Memory setting. Bring
up a software program that you often use to print.

From the File menu, choose Print or Page Setup.

Choose the Setup button. (Depend) on your software, you might
need t0 choose Options or Printer.)

If prompted to select a printer, select ActlonLaser 1400.

When the Paper Setup dialog box appears, change the Memory
setting for the amount of memory now installed in the printer. (Be
sure to include the 2MB already installed.)

Choose OK to close dialog boxes. When you return to the Print dialog
box, choose Cancel.
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Checking the memory

To verify that memory is correctly installed, print a test sheet by pressing
the reset button at the back of the printer.

If an incorrect amount of memory is shown on the test sheet, turn off the
printer and remove the metal access cover. Make sure you correctly
installed the SIMM or SIMMs. If the amount of RAM is still incorrect,
contact your dealer or a qualified service person for assistance.

D-4
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Glossary

Auto line feed

A printer feature in which each carnage return code (CR) is automatically
accompanied by a line feed (LF) code.

control codes
Special codes used to control printer functions such as performing a
carriage return or line feed.

default

A value or setting that takes effect when the printer is turned on, reset, or
initialized.

download

To transfer information from the computer to the printer. Fonts are
downloaded to the printer when needed.

dpi
Dots per inch. The number of dots per inch is a measure of printer
resolution. The higher the number of dots, the higher the resolution

driver
See printer driver.

drum

The part of the toner cartridge where the image is formed and transferred
to the paper.

edge smoothing
A feature that smooths the jagged edges of printed lines or shapes.

emulation
See printer emulation.

ESC (escape) code
A special control code used to begin most printer commands.

font

A set of characters and symbols that share a common typographic design
and style.

halftone

A grayscale image that is composed of small dots. The dots can be close
together to create black or more widely spaced to create gray or white
areas in the image. Newspaper photographs are common examples of
halftones.
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interface
The connection between the printer and the computer.

landscape
Printing that is oriented sideways on the page. This orientation gives you
a page that is wider than it is high and is useful for printing spreadsheets.

memory

The part of the printer’s electronic system that is used to store
information. some information is fixed and is used to control how the
printer operates Information that is sent to the printer from the computer
(such as downloaded fonts) is stored temporarily.

orientation

Refers to the direction in which characters are printed on a page. This
direction is either portrait with the text printed across the width of the
page, or landscape with the text printed across the length of the page.

PCL 5e
The command language built into the Hewlett-Packard LaserJet 4P.

point size

The height of a particular font as measured from the top of the tallest
character to the bottom of the lowest. A point is a typographic unit of
measure equivalent to 1/72 of an inch.

portrait

Printing that is oriented upright on the page (as opposed to landscape, in
which printing is oriented sideways on the page). This is the standard
orientation for printing letters or documents.

printer driver
The part of a software program that converts commands from the
program into commands used by the printer.

printer emulation

A set of operating commands that determines how data sent from the
computer is interpreted and acted upon. Printer emulations replicate
existing printers, such as the HP LaserJet 4P.

reset
To refresh the printer's memory and erase the current print jobs, and reset
printer settings to the factory defaults.

resident font
A font that is stored permanently in the printer% memory.
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resolution
A measure of the fineness and clarity of images produced by the printer
or monitor. Printer resolution is measured in dots per inch.

symbol set

A collection of symbols and special characters. Symbols are assigned to
specific codes in a character table.

test sheet
A report that lists the printer settings and other printer information.

toner cartridge

The consumable part of the printer that contains a photosensitive print
drum and the toner supply.

TrueType

An outline font format that was developed jointly by Apple® Computer
and Microsoft Corporation. TrueType fonts are outline fonts that can be
easily resized for screen display or for printing.
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Index

This index contains entries for this manual as well as the Read This First guide.
Page numbers from the Read This First guide are preceded by RTF (e.g., RTF-9).

A

About,

Accessories, EPSON,
Adjusting toner density,

B

Bidirectional parallel interface
installing the cable, RTF-12

pin assignments,

Bitmaps

converting TrueType fonts,

2-10-11

Blank pages,

Button, see Reset button

C

Cartridge, see Toner cartridge
Choosing paper,
cleaning the printer, 3-11-12
clearing errors,
CompusServe membership, @
controlling the printer

from DOS, B-4-8

from_Windows, 2-2-13

Copies,

D

Dark background, [3-5
Downloaded fonts m
Draft documents,
Driver, see Printer driver

E

Edge Smoothing,
changing the setting, 3-8-9
Electrical specifications, | A-4
Energy Star compliance,
Envelopes 1
feeding_manually, [2-6]
sizes, b
Environmental specifications,
EPSON Accessories,
EPSON Connection,
EPSON Control Panel for DOS, B-2-8
installing,
EPSON Control Panel for Windows,
deleting, 3-13-14
|nstaII|ng RTF-14

minimizing, [1-11]
Error light, [ 1-10]

Errors, recovering from,

F
Faint images,
Feed jams

clearing, RTF-21
preventing, 3-2-3

Font Manager,

Fonts,
downloading
installing PCL fonts,| 2-13
printer resident fonts,
printing TrueType fonts as

graphics, 2-10-11

problems with

substituting_printer resident
fonts, | 2-11]
Front panel Tights,| 1-10}




G

Graphics
applying halftone patterns, |2-10
printing as HP-GL/2, raster,|2-9
printing at lower resolutions, |2-9
problems with, 3-4-5

Graphics Mode,
Graphics Quality, [2-9
Gray Scale,| 2-10|
Green settings, 2-7-8

H
Halftones, applying to graphics,[2-10]
Help,

accessing from EPSON Control
Panel for DOS, |B-6}

etting support, |1
HP? GL/? gragﬁics -9
Horizontal lines, [3-6

Installing
additional memory, D-2-3
EPSON Control Panel for DOS,
B-2-3
EPSON Control Panel for
Windows, RTF-14
toner cartridge, RTF-3-6

Interface, specifications,

L

Labels,

Landscape orientation,

Laser SCanner window, cleaning
-3-12

Light images,
Line Art Images] 210
LJ4P emulation,

command summary, C-2-14
Loading paper, 1-5-6, RTF-7-10

M
Manual feed,[1-7]2-6|

Memory,
adding, D-2-3
clearing,

Memory setting,

O
Orientation, [2-5

P
Page Protection,

Paper
choosing,
loading, 1-5-6, RTF-7-10
problems with jamming, 3-2-3
reloading, RTP-10
specifications,
Paper Feed,
Paper jams,
clearing, RTP-21-24
preventing 3-2-3
Paper release lever, [1-5]
Paper Size,
Paper tray,|1-5|
loading paper, 1-5-6, RTF-9-11
Parallel interface
installing the cable, RTF-12
pin assignments, A-6-7
PCL fonts, installing,[2-13|
PCL 5¢ command language,
Photographic Images.
PJL mode, commands,[c-14
Portrait orientation, |2-5
PostScript emulation option,
Power, conserving,
Power consumption,
Power cord, installing, RTF-11
Power Saving Interval
Power saving mode,|1-12

setting,




print quality
optimizing, 3-8-10
problems with, 3-5-8
Printable area,
Printer
cleaning, 3-11-12
controlling from MS-DOS, B-2-8
controlling Windows, 2-2-13
features,
maintaining, RTF-17-24
monitoring the status, 1-9-11
resetting,
setting up, RTF-1-15
specifications, A-3-5
system requirements, RTF-1
testing, RTF-12
testing the computer connection,
RTF-13
unpacking, RTF-2
Printer driver, RTF-14
Printer driver_settings, 2-4-13
accessing, [2-3]
resetting to factory default
saving as a profile in DOS,[B-7]
Printer_overruns, preventing m
Profiles,

R
Raster graphics
Ready light,|1-10]

doesn’t come on, [3-3]
Reporter, [1-3] B-7-8
Reset button, RTF-12
Resident fonts,
Resolution,

changing for graphics,

S

safety instructions
scanned Images,|2-
Setup dialog boxes,
SIMM
installing, D-2-3
specifications,
Status, monitoring, [1-3] 1-9-11

!

1

T

Test page, printing, RTF-12
Toner
adjusting the density,[3-10]
cleaning spills
conserving,
problems with smudges, [3-6]
Toner cartridge
handling precautions, @
installing, RTF-3-6
replacing, RTFE-17-21
specifications
Toner density, |2-§
adjusting, |3-10]
Toner Saving,
Toner saving mode
Transparencies,
TrueType fonts
converting to bit images, 2-10-11
downloading,
resident in printer,[1-g]
using printer TrueType fonts, [2-11]

\%
Vertical bands,
W

Window envelopes,

IN-3
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